2D crtanje
kotiranje crteza sa prethodnog casa
primer 2- gornja projekcija
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Otvoriti primer sa prethodnog casa.
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Zadati crtez



Korak 22: Kotiranje crteza

Kote ¢emo da postavimo na lejer Kote koji smo definisali za njih na poCetku

izrade crteza

Pre pocCetka kotiranja potrebno je postaviti parametre kotnog stila kao Sto su:

veliCina kotnog broja, tip i veliCina kotne strelice, polozaj kotnog broja na kotnoj

liniji, itd. Sablon koji smo otvorili prilikom zapog&injanja izrade novog crteZa u

sebi sadrzi definisan kotni stil u ISO sistemu ISO-25. Geometrija kota u ovom

stilu prilagodena je crtezu formata A4. Na slici prikazan je polozZaj kotnog

stila u Styles pale’gj.
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Izabrati layer: kotne linije

Iy ReEeImETml) -

i @ kotne linije
i M osne linije

i M pomocne linije
1 O srafura
O zaglavlje

* Pre pocCetka kotiranja, treba da izvucemo
paletu dimension i da se upoznamo sa
oshovnim komandama.

 Tools-> Toolbars—> AutoCAD->Dimension
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linear arclength diameter baseline tolerance dimension text edit

Komande za kotiranje su:

Linear komanda iscrtava kotne linije 1 mern odstojanja u
horizontalnom/vertikalnom pravcu;

AlLigned komanda iscrtava kotne linije 1 meri odstojanja u pravcu koji je
paralelan sa pravcem elemenata;

ROtated komanda iscrtava kotne linije 1 men odstojanja pod zadatim
uglom;

COntinue komanda nastavlja kotnu liniju na prethodno zavrsenu.
DIMCONTINUE, omogucava korisniku da stalno unosi  drugu
ekstenzionu liniju, bez izlaska 1z kKomande;



Baseline komanda Iiscrtava paralelne kotne linijje od zajednicke
poCetne linijje (taCke) na zadatom medusobnom rastojanju. Komanda
DIMBASELINE omogucava korisniku da stalno unosi  drugu
ekstenzionu liniju, bez izlaska iz komande;

OBlique komanda omogucava korisniku da horizontalnu kotnu liniju
postavi pod nekim uglom u odnosu na originalno stanje. DIMOBLIQUE
komanda radi istu stvar kao | komanda OBlique u DIM promptu;
Diameter komanda omogucava kotiranje precnika kKruznice ili luka i ima
mogucnost da obelezi tatku centra. U DIM promptu istu stvar radi
komanda DIMDIAMETER;

RAdius komanda omogucava Kotiranje poluprecnika kruznice ili luka |
Ima mogucnost da obelezi tacku centra. U DIM promptu istu stvar radi
komanda DIMRADIUS;

CEnter komanda omogucava Korisniku da oznacl polozaj centra ili
centralne linje kruznice il luka. U DIM promptu istovetna je komanda
DIMCENTER,;

ORdinate komanda omogucuje Kkorisniku da bira orjentaciju ordinata.
Ova komanda ima tri opcije:

ANgular komanda generise Kotni luk | mer velicinu ugla izmedu dva
odabrana pravca;

Leader komanda omogucava izvodenje kotnog teksta na novu lokaciju i
crta liniju kojom se tekst vezuje za kotirani element;

TOLERANCE komanda omogucuje Kkorisniku da definise tolerancije
mera;

Dim. text edit komanda omogucava korisniku da pomeri kKotu i kotni
broj na crteZu.



Polozaj linearnih kota u odnosu na zadati crtez.

@ 0,14

@ 0,7

@-7,0




Pozovite komandu za linearno kotiranje:

Command: dimlinear Kod kOte.
First extension line origin or press ENTER to select: 21 dvoklik
Selektujte tacku 1 na slici. | uneti
Second extension line origin: Selektujte tacku 2 na slici. prefiks
Dimension line lDCatlt?Il . %%c, to je
(Mtext/Text/Angle/Horizontal/Vertical /Rotated) :

oznaka za
@-7,0 .
Dimension text = 20 fi.
Ponovo pozovite komandu za linearno kotiranje. \ﬂ% '
Command: dimlinear S
First extension line origin |
or press ENTER to select:
Selektujte tacku 3 1 g2=3 | !
Second extension line ﬁ 2 -
origin: Selektujte tacku 4. - -

Dimension line location

(Mtext/Text/Bngle/Horizontal Q

/Vertical/Rotated): @0,-7

Kotirame dve ivice predmeta

MNa ova] nacin smo iskotirali dve kote. Obratite paznju da smo uneli relativhe
koordinate za rastojanje glavne kotne linije od kotirane ivice (-7 u x pravcu i -7 u

¥ pravcu).
Ma i1sti nacin iskotirajte 1 ostale horizontalne/vertikalne kote na criezu.



Kotiranje radiusa

Pozvati komandu za kotiranje radiusa i
selektovati tacku 1 i postaviti kotu na mesto levim klikom misa.
Ponoviti istu komandu za tacku 2.




Kotiranje precnika

Aktivirajte komandu dimension style... sa alata za kotiranje i u dijalogu za podeSavanje
kotnog stila (slika) odaberite taster New. Podesite naziv kotnog stila na Precnik. U
kartici Fit->Fit Options, selektujte opciju Both Text and Arrows. Ovo ¢e vam

omoguciti da pri kotiranju precnika budu prikazane i kotne strelice i kotni broj.
Aktivirajte novi kotni stil i pozovite komandu za kotiranje precnika
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Lines  Symbols and Amows Text  Fit

B Create New Dimension Style

Mew Style Name:

o |
Start With: CEFICEJ
|50-25 -
Hel
[ ] Annotative E
lse for:

All dmensions

Group
- [':'1*

Groups =

Precnik

A Annotative
[50-25

Precnik

Standard

Fit options

If there isn't enough room to place both text and
amows inside extension lines, the first thing to
move outside the extension lines is:

() Either text or amows (best fit)

() Amows

() Text

(®) Both text and amows

() Always keep text between ext lines

[ ] 5uppress amows if they don't fit inside
extension lines

Text placement

When text is not in the default position, place it:
(®) Beside the dimension line

() Ower dimension line, with leader

() Ower dimension line, without leader

Primany Units  Altemate Units  Tolerances

411
5 iy
® 2,
G
..\
oS
&>
Scale for dimension features
[ ] Annotative

(") Scale dimensions to layout
(®) Use overall scale of: 1 =
Fine tuning

[] Place test manually

Draw dim line between ext lines

Cancel Help

Odabrati kotni

stil,precnik.




Pozovite komandu za kotiranje precnika, selektujte tacku 3 i postavite kotu,
ponovite komandu, selektujte taéku 4 | postavite kotu.
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Primeticete da su radijusi korektno iskotirani, ali precnici nisu
dobro iskotirani, sto znaci da ¢emo morati korigovati stil
kotiranja za dve kote precnika.

To ¢cemo uraditi na sledeci nacin. Primeticete da pri kotiranju
precnika program automatski dodaje simbol ¢ ispred
dimenzije (koji nije potreban tu da stoji jer se sa crteza vidi da
je kotirana kruznica).



Korak 23: Srafiranje polupreseka

Srafiranje je poslednja operacija koju ¢éemo uraditi. Pozovite komandu Hatch.
Za tip Srafure odaberite (Patern) ANSI31, to je Srafura sa linijjama pod uglom od
45° Gustinu Srafure ostavite 1, ako dobijete gustu Srafuru mozZete ovaj
parametar povecati. Obratite paznju da svaka Srafura u sebi ima definisan
ugao, pa relativni ugao ostavljamo sa vrednoscu 0. Jos je ostalo da se selektuju
oblasti na criezu koji e se Srafirati. Odabernte opciju Pick Points 1 selekiujte
tacke 1 12 na slici, zatim pritisnite Enter i aktivirajte taster Apply. Trebalo bi da
dobijete crtez kao na slici.

B select

20

R SOLID ANGLE ANSIE1 ANSIZ2

Boundaries « Pattern

Srafiranje crteza



Korak 24: Dodavanje zaglavlja u crtez

Zaglavlje za crtez dodacemo na lejer zaglavlje, koji ¢emo prethodno
aktivirati.

Za ubacivanje prethodno generisanog crteza (u vom slucaju crtez
zaglavlja) iskoristi¢emo komandu Insert Block iz Draw palete sa alatima.
Ovu komandu mozete pozvati i preko padajuceg menija Insert->Block.
Nakon poziva komande aktivirace se dijalog prikazan na slici.

~ InNsen Ehe{H

gowse  <——— Pytanja do fajla

— T =

Polozaj donjeg levog Razmera za zaglavlje Rotacija zaglavlja
ugla zaglavlja



Referentna tacka predstavlja donji levi ugao crteza koji se ubacuije.

Postavi¢éemo zaglavlje tako da se ta tacka smesti u koordinatni pocetak (0,0,0).
Zaglavlje je nacrtano u razmeri 1:1, i orjentisano je kako treba da stoji na crtezu,
tako da parametar za rotaciju zaglavlja ostavite da bude 0. Da vas program ne
pita za parametre prilikom ubacivanja zaglavlja ostavite opciju Specify Onscreen
Praznu kao na prethodnoj slici.
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Prvo ¢emo nacrtati gornju projekciju.
Pre pocetka crtanja, kao i na prethodnom primeru, treba da otvorimo odreden format
crteza i da prilagodimo granice.

Da bi bili sigurni da su jedinice u kojima crtamo crtez u metrickom sistemu
(mm), svaki novi crtez po¢e¢emo otvaranjem Sablona u ISO sistemu. Ovo
mozemo uraditi pozivanjem File->New komande i odabirom acadiso.dwt fajla.
Za razliku od formata AutoCAD crtezZa koji ima ekstenziju DWG (DraWinG),
ekstenzija Sablona je DWT (DraWing Template). Pored mernih jedinica, u ovom
Sablonu su definisani tekst, kotni stilovi, tipovi linija u mm.

Definisanje granica (formata) crteza omogudéava komanda LIMITS. Moze se
pozvati iz komadne ilinije ili preko Format->Drawing Limits komande.



Korak 1: PodeSavanje granica crteza

Command: LIMITS
ON/OFF/<Lower left corner><(0.0000,0.0000>: 0,0
<Upper right corner><420.0000,297.000>: 210,297

Command: GRID
Grid spacing (¥) or
ON/OFF/Snap/Aspect<10.0000>: |

no

Command: ZOOM

All/Center/Dynamic/Extents/Left/Previous/Vmax/Window<
Scale (X/XP>: [Broj] Aall



Korak 2: Podesavanje layera

Pre pocCetka crtanja gornje projekcije podesiéemo layere koji ée nam biti
potrebni priizradi crteza. Preko komande Layer Properties Manager
pokrenuéemo dijalog za podesavanje layer-a u crtezu.

Doda¢emo pet novih layera Pomocne,

Osne, Kote (komandom New Layer), srafura i zaglavlje. Boje i debljine linija
podesi¢emo kao na slici. Podesiéemo da tip linije za layer Osne bude
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Korak 3: Crtatanje pomoc¢nih linija
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Prvo éemo nacrtati dve pomocne linije, na sloju pomocne
linije, komandom XLINE. Jednu horizontalnu liniju i jednu
vertikalnu.
Comand: Xline

h
Postaviti proizvoljno horizontalnu liniju, zatim istim
postupkom, postaviti vertikalnu.
Comand: Xline

v




Korak 4: Crtanje spoljasnje konture

Pre pozivanja komande LINE, prebaci¢emo se na sloj 0. Na slici vidimo izgled crteza
nakon ove komande.

Command:LINE

From point: ( prvu tacku odabrati u preseku pomoénih linija)
To point: @150,0
To point: @0,30
To point: @-60,0
To point: @0,-10
To point: @-50,0
To point: @0,5
To point: @-40,0
To point: ¢




Korak 5: komanda Offset

Komandom offset, docrtacemo linije koje su iste duzine kao neke ve¢ nacrtane
linije i nalaze se na tacno odredenom rastojanju.

OFFSET Specify offset distance or [Through Erase Layer] <Through>: 5

= OFFSET Select object to offset or [Exit Undo] <Exit>: Selektovati liniju koju prikazuje strelica i zatim
kliknuti levim tasterom misa, bilo gde iznad
linije. Na donjoj slici je prikazan crtez nakon
ovog koraka.
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Korak 6: komanda Offset

Ponovicemo ovu komandu opet. Ista linija se selektuja, ali je rastojanje ovoga
puta 10 i klikne se ispod linije.
Na slici je prikazan crtez nakon ove komande.



Korak 7: docrtavanje linija

Pre nego Sto pozovemo komandu za crtanje linija, potrebno je

odabrati opciju u Osnap dijalogu za selekciju tacaka pod pravim uglom (opcija
Perpendicular).

Kliknite desnim tasterom misa u statusnu liniju na taster Object Snap i odaberite
opciju Settings.

U dijalogu selektujte opciju Perpendicular sto je prikazano na slici.

|
;ﬁnﬁmmg Settings i e

| Snap and Grid I Palar Tracking | Object Snap |3D Object Snap I Cyramic Input I Quic| 4 |+

Ohject Snap On (F3) [T] Object Snap Tracking On (F11)
Ohject Snap modes

O Endpaint - Bxtension Select Al

A O] Midpoint 04[] Insertion

) Center B0 Perpendicular

3 [] Geometric Certer T[] Tangent i
N =[] Node =[] Nearest
L > [ Guadrant B[] Apparent intersection

Y Intersection < [] Parallel
| T To track from an Osnap point, pause over the point while in a

g command. Atracking vector appears when you move the cursar,
To stop tracking, pause over the poirt again.

L i

k) (o) ()




Korak 7: docrtavanje linija

B

Sada mozemo komandom line da nacrtamo zeljene linije. Pozvati
komandu Line, poCetna tacka je uzeta kao krajnja tacka, na slici gore, a
druga tacka je prikazana na donjoj slici. Sa slike vidimo da se ukljucio
osnhap, perpendicular.

Isto to ponoviti i sa druge strane.

Perpendicular




Korak 8: komanda Offset

Sada ¢emo nacrtati liniju kuju prikazuje
strelica. Nacrtademo je komandom offset.
Prvo moramo da izraCunamo rastojanje, to
¢emo uciniti na slededi nacin: od precnika
40, oduzecemo precnik 25 i podeliti na dva
dela.

(40-25)/2=7.5

Comand:

Offset: 7.5

Selektovati krajnju levu, plavu
liniju i kliknuti sa desne strane.



Korak 9: komanda Offset

Sada ¢emo nacrtati komandom offset liniju koja
se nalazi na 25 mm sa desne strane od
novodobijene linije.

Comand:

Offset: 25

Selektovati plavu liniju i kliknuti sa desne
strane.

Korak 10: komanda Offset

Na slican nacin éemo sa druge strane
nacrtati paralelne linije. Prvo moramo da
izraCunamo rastojanje, to ¢emo uciniti na
slededi nacin: od precnika 60, oduzecemo
precnik 25 i podeliti na dva dela.
(60-25)/2=17.5

U

!



Comand:

Offset: 17.5

Selektovati krajnju desnu, plavu

liniju i kliknuti sa leve strane.

Korak 11: komanda Offset

Sada ¢emo nacrtati komandom o ffsetliniju koja
se nalazi na 25 mm sa leve strane od
novodobijene linije.

Comand:
Offset: 25
Selektovati plavu liniju i kliknuti sa leve strane.



Na slici je prikazan crtez nakon svih offset komandi koje
smo uradili.

Naravno, ove linije smo mogli dobiti i na drugi nacin, na
primer preko komandi xline i line.



Korak 12: Docrtavanije linija
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Treba da nacrtamo ovu horizontalnu liniju na i A
5 mm od donjei treba da docrtamo ove dve 90°

linije koje se nalaze pod uglom od 90°. Da
bismo to uradili, prvo se trebamo prebaciti na
sloj (layer) pomo¢éne linije. Kada smo
promenili layer, treba da nacrtamo prvo jednu
offset liniju na 5 mm i dve pomoc¢ne linije pod
uglom od 45° i -45°,




==== Command: XLIME
Pozvati komandu xline i odabrati opciju offs8t, - XLINE specify a point or [Hor Ver Ang Bisect Offset]: a

rastojanje je 5mm. Treba selektovati donju i
liniju, koju pokazuje strelica na slici i kliknuti

bilo gde iznad, potom na esc. . |
Pozvati komandu xline i odabrati opciju ANG, /// ,

potom uneti vrednost ugla 45° i postaviti liniju o A
kroz presecnu tacku koja je prikazana na slici | ; ]/i\

ispod levo. Isto poniovit za ugao -45 °(slika -
dole desno).




Sada mozZemo nacrtati linije po pomoénim linijama. Pre nego Sto to
uradimo, treba da se vratimo na sloj 0.
Sada pozvati komandu line i nacrtati linije kao Sto je prikazano dole.




Korak 13: Brisanje linija komandom TRIM

Treba da obriSemo dve linije koje pokazuju
strelice. Pozvati komandu trim, desni taster
misa kliknuti bilo gde u prostor i potom
levim tasterom misa na ove dve linije koje
Zelimo da obrisSemo. Slika dole pokazuje
crtez nakon komande trim.




Korak 14: Zaobljavanje ivica

@60
@25 . @10

240

025 & £

|

25

NN

15

30

—5
NN

150 90°

Sada treba da zaoblimo ove radijuse R3, imamo ih ukupno 4. Komanda za
zaobljavanje je Fillet.

Comand:

# = FILLET Select first cbject or [Undo Polyline Radius Trim Multiple]: r

# = FILLET Specify fillet radius <B8.88088>: 3

potom oznaciti izmedu koje dve linije se nalazi ovo zaobljenje.

Ponovitio ovu komandu za sva 4 zaobljenja. Posto su isti parametri, mozete
samo na enter ponovo pozvati komandu i samo oznaciti sledece dve linije
izmedu kojih se nalazi zaobljenje.




Izgled crteza nakon zaobljavanja.




Korak 15: Pozicioniranje otvora

|
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Da bismo nacrtali
zaokruzZeni crveni otvor,
moramo pogledati i
donju projekciju. Osna
linija ovog otvora se
nalazi na precCniku 40, sto
znaci da je udaljena 20 od
centra kruznice.

Prvo ¢emo se prebaciti na
sloj za pomocéne linije.

Prvo ¢emo nacrtati
pomocdnu liniju koja
prolazi kroz centar
kruznice. Ona je na
rastojanju 25/2=12.5, to
nam je zaokruzeno Zutim
pravougaonikom.



Sada ¢emo pozvati komandu za pomocnu liniju xline, offset na 12.5.
Potom oznadciti liniju prikazanu na slici strelicom i kliknuti bilo gde desno.

I
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| ] | x|
=] =]
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] ]

= - 47 o
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Izgled nakon
postavljanja pomocéne
linije

Ponovo pozvati xline, offset na 20. Sada oznaciti pomocnu liniju koju smo malopre
nacrtali i kliknuti desno od nje.



Izgled nakon crtanja druge
pomocne linije.

Ostalo nam je jos da
nacrtamo jednu pomoénu
liniju paralelnu sa ovom koju

smo sada nacrtali na
rastojanju od 5 mm.

Ponovo pozvati xline, offset na 5. Sada oznaciti pomocnu
liniju koju smo malopre nacrtali i kliknuti desno od nje. Na
slici ispod je prikazan crtez nakon ove komande.

=




Korak 15: Crtanje otvora Prvo treba da se vratimo na sloj 0.

Potom pozvati komandu line.

d

—

Command:LINE

From point: (pocetna tacka je prikazana strelicom)
To point: @0,-15

To point: @-5,-3

To point: @-5,3

To point: @0,15

esc

Izgled nakon komande line



Ostlo je josS da spojimo liniju komandom
line.

Ppozvati komandu line i spojiti od presecne
do presecCne tacke.

Crteze je prikazan na slici ispod, nakon ovog
koraka.




Korak 16: Crtanje srafure

Ostalo je jo$ da uradimo $rafuru. Prvo o e M Contin.. = 0.50..
kotne ' 92 Continu.. — 0.20..

¢emo se prebaciti na sloj Srafura. Na sloju ]
’, . e . e 1. asne ' - ACADIS.. — 0.20...
za pomocne linije ugasi¢emo sijalicu, da s y % b Conty. — 020,

— 0.20...

bismo imali manje polja kod srafure. « zaglavije ' ... Continu..

Srafiranje je poslednja operacija koju ¢éemo uraditi. Pozovite komandu Hatch.

Za tip Srafure odaberite ANSI31, to je Srafura sa linijama pod uglom od 45°
Gustinu Srafure ostavite 1, ako dobijete gustu Srafuru mozete

ovaj parametar povecati. Obratite paznju da svaka Srafura u sebi ima definisan
ugao, pa relativni ugao ostavljamo sa vrednos¢u 0. Jos je ostalo da se selektuju
oblasti na crtezu koje ¢e se Srafirati. Odaberite opciju Add Pick Points i

selektujte polja gde pokazuju strelice, zatim pritisnite Enter i aktivirajte taster OK.
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Hvala na pazniji.



